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WHAT' S HOT

THE WEEK'S TOP HEADLINES IN PHOTOGRAPHY

NIKON'S NEW Z00M COULD BE
THE ONLY LENS YOU NEED

Nikkor Z 28-400mm f/4-8 is Nikon's most versatile lens for full-frame Z mount

ikon has unveiled the Nikkor
Z 28-400mm f/4-8 VR, a
full-frame superzoom for its

Z-mount mirrorless cameras that sets
a new standard for an all-in-one zoom
lens with its phenomenal 14.2x zoom
ratio. The lens is also compatible with
APS-C DX Nikon cameras, such as the
Z50 and Zfc, on which the effective focal
range becomes 42-600mm.
Superzoom lenses offer an all-in-
one solution, covering everything from
wide-angle to telephoto focal lengths,
and opening up new possibilities for
your photography or filmmaking. The

longest-range superzoom previously
available for Nikon cameras was the
Tamron 18-400mm f/3.5-6.3 Di Il VC
HLD, which could only be used on Nikon
F-mount DX-format DSLRs.

Whether you're shooting sports or
wildlife, or in any scenario where subject
distance varies continuously, this lens
enables you to adapt to any situation
with ease. Its versatility means you could
rely on just this one lens to capture a
wide range of scenes, eliminating the
need to switch between multiple lenses.

What's more, the lens excels in close-
up photography, with a minimum focus

distance of just 0.2m at the widest angle
and 1.2m at the maximum telephoto
position, while offering a maximum
reproduction ratio of 0.35x.
It features a stepping motor
(STM) for fast autofocus, and built-in
Vibration Reduction provides up to a
5-stop benefit. Despite its impressive
telephoto reach, the lens has a compact
and lightweight design, weighing
approximately 7259, which makes it the
perfect lens for travel and everyday use.
The Nikon Z 28-400mm f/4-8 VR
will go on sale from mid-April priced
at £1,399 / $1.290.

© Nikon
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CUT LOOSE

Photography can be more
than a representation of reality.
It can transform subjectsin a
way that opens up a new level
of perception for the viewer

SHOOT ABSTRACT

Think outside the box to cross the line from reality-based
Images to mesmerising abstract photo art

Words Kim Bunermann

bstract photography is a
e dynamic and varied genre that

presents endless opportunities
to explore and unleash your creativity.
In the early days of photography, there
was little room for abstract frames. The
first cameras served the sole purpose
of capturing scenes as they appeared
in real life, providing a more accurate
depiction than paintings.

However, like most art forms,
photography evolved, and began to
find its creative voice as a reaction
against expressionism in the 1920s,
when photographers such as Albert
Renger-Patzsch freed the medium
from its initial function. This period saw
the emergence of movements such

as New Objectivity and New Vision,
where photographers embraced a
fresh approach to discovering the
technical possibilities of photography
to showcase structures, forms and
angles in innovative and exciting ways.
To create frames that offer a fresh
and unique perspective on familiar
subjects, the key is to break away from
preconceived notions by transforming
the ordinary into the extraordinary. This
often means removing subjects from
their usual context, which renders the
functions of objects less important.
Instead, the focus shifts to the optical

characteristics of materials and colours.

To experience subjects in a new
and extended way, we need to train

our eyes and develop the necessary
observation skills, while also trusting
our vision. Breaking traditional
photographic rules is an important

part of this process, even though it
may be easier for some than for others.
However, abstract photography is

a genre that allows us to have fun,
experiment and discover.

Over the next few pages we'll
explore some abstract techniques that
you can adapt to other photographic
genres, and which will let you showcase
your creative side. You'll learn how to
find fresh perspectives on everyday
objects and familiar scenes, and how to
transform them in a game of hide and
seek with the viewer.
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ny image that does not show
e reality can be considered

abstract. Although people
might perceive the level of abstraction
in different ways, as long as the
photograph causes the viewer to
question what they are seeing, it can
be considered a successful abstract
frame. The easiest way to portray any
subject in an abstract way is to free
yourself mentally from its concepts
and functions. Abstract photography
doesn't have to explain what is
depicted; in fact, the aim is not to do so.

The most important skills for abstract

photography are observation and
perception. Freeing your mind from
the functions that the material world

and society have ascribed to the object
you're shooting means you can alter
the subject’s context from its reality. To
do this, select a subject and observe
and analyse it. Take your time, move
it, or move around it, get closer, and
see how it looks in different lighting.
Work out what makes the object
interesting or unique, and concentrate
on enhancing those features. Try doing
this as a weekly challenge, with the aim
of training your mind to look out for
possibilities, and also to become more
familiar with the way your camera and
lens work.

In terms of the composition, aim to
give the viewer direction to help them
explore the image, using leading lines

GET CLOSE

Macro lenses let you
transform everyday objects
with underlining optical
characteristics like material
and structure

THE RULES

When it comes to abstract
photography, the sky's the limit.
Experimenting, and overlooking

the classic photography rules
and techniques - for example in
terms of the shutter speed - will
help you make even the most
ordinary subjects appear
mysterious and
interesting.

and a strong focal point to guide their
eyes. While traditional composition
rules, such as the rule of thirds and the
golden ratio, are handy, it's good to
think more abstractly.

Especially when you're filling the
frame with the subject, leading the
viewer's eye is crucial. Start by taking a
wider shot of the subject, and then get
progressively closer with each photo.
This will help you identify where the
leading lines and other visually dominant
elements are in your frame. Keep
getting closer until the composition of
the frame provides the viewer with a
mystery to solve, where the subject is
transformed and incorporated into a
supporting composition.
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ISOLATE FOR ALIENATION

Get up close to your subject, and frame tight to discover fresh perspectives

on ordinary items

A popular method for creating abstract
frames is to isolate the subject from

its surroundings, offering the audience
a different view that deviates from
reality. Two ways to achieve this are by
incorporating negative space to give the
subject room to breathe, or by taking
close-up shots to fill the frame to the
maximum. The latter allows the viewer
to focus on the unique features of the
subject’s material and colour.

Here, macro lenses with at least a 1:1
reproduction ratio are recommended, such
as the budget-friendly AstrHori 25mm
f/2.8 2-5X Ultra Macro opitic. It can focus
down to 113mm at 2x magnification, or
186.4mm at full 5x magnification. However,
if you're new to abstract photography,
most kit zoom lenses are also suitable.
Often these lenses have decent close-
focusing capabilities, and you always have
the option to crop the frame even further in
post-processing.

To achieve the best results while
maintaining high quality and sharpness,
choosing an aperture of f/8 works best.
As the depth of field can be shallow when
using a macro lens, even if you're working
with narrow apertures, the focus-stacking
technique comes into play. This approach
is highly effective when capturing still
subjects, and involves stacking several
images at the post-processing stage.

FILL THE FRAME Monochromatic subjects can
often create a calm and harmonic frame, letting
the viewer focus on the details

COMPRESS YOUR IMAGE ELEMENTS

Bringing elements closer together can help you to manipulate reality

Depending on the subject you want to
transform, a telephoto zoom lens can be a

great tool. Due to its versatility, it allows you

to explore scenes with a different approach
and from a different perspective than a
macro lens. A zoom lens has more to offer,

especially when photographing architecture.

Due to its compressed perspective, the
foreground and background appear
closer together at narrow focal lengths.
The Canon EF 70-300mm f/4-5.6L
IS USM, for example, is a relatively
budget-friendly professional lens
with rapid, virtually silent autofocus.
However, telephoto zoom lenses
aren't cheap, and to avoid going
over your budget, it's a good idea to
consider second-hand options. MPB is
one provider of pre-used kit that carries
out checks on the functionality of a lens
before it goes on sale online.

STACK SHOTS FOR DEPTH

SECURE THE CAMERA

For the highest-quality image, go to the menu
and select raw as the file format, and to enable
easy image alignment mount your camera on
a tripod. Now activate the live view to help you
decide on framing and composition.

SWITCH OFF AF

Set your camera to manual focus (MF) and
turn off any image stabilisation modes. In
manual mode, select an aperture of f/11, set the
shutter speed to around 1/200 sec, and adjust
the ISO until you achieve a well-exposed image.

Drive Mode

SET THE FOCUS

Select the two-second self-timer or use a
shutter remote release to avoid camera shake
and blur. Now focus on a specific area, press
the shutter, and continue without reframing the
scene until all the elements are captured.

Auto-Align Layers

Leng Commaction

Vignetis Removal

STACK IN POST

In Photoshop, select all layers and go to
Edit > Auto-Align Layers. Go to Edit > Auto-
Blend Layers, choose Stack Images, Seamless
Tones and Colors and Content Aware Fill
Transparent Areas.




hen we're creating photographs
hat deviate from our perception
of reality, the subject is
independently reshaped to create an
additional level of interest. This can
be achieved by adapting the material
and visibility of the subjects, or by
using photographic techniques. One
such subject is light, which offers great
creative potential.
Light is a crucial tool for photography.

whether it's natural or artifi
from a flash. It can be used
different visual effects, and ¢
shaped and combined with c
to create unique compositions
the light is more controllable |
sunlight can also be great for ¢
abstract frames. For example, a
midday sun creates high-contra
shadows that can contribute to anc
become part of the composition.

LIGHT PAINTING
_ ~ If you're working with light and
o g exposures, combining different
red lights and movements can
bring your vision to life
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CHOOSE THE OPTIC

You can create full-frame bokeh
with most lenses, but if your goal is
to achieve natural-looking, circular-
shaped light sources, a nine-blade
lens is ideal. Lenses with fewer
blades create polygon-shaped orbs

'}

DIAL IN CAMERA SETTINGS
Shoot in M and deactivate the AF
function. Now choose the maximum

OEO®OLVREG
LET THERE BE LIGHT conrmuen

\BSTRACTION

open aperture setting, and adapt the
shutter speed and ISO values until the
exposure is balanced. When working

in the dark, using a tripod allows you
to use longer exposures.

PLAY WITH WAVELENGTHS

Create abstract images that we can't perceive with the naked eye

When taking an abstract
approach, an extended shutter
speed provides the opportunity
to get creative with light, such as
turning an existing scene around
or constructing a conceptual
photograph. In both scenarios,
the light sources need to

stand out, so the backdrop
should be dark.

One approach is to capture
the light of moving objects,
such as cars, to create light
trails. You can also move
the camera to control the
shape of light sources -
this approach is called
intentional camera
movement (ICM),
and we'll explore
this further on the
following pages.

To bring your
vision to life, you
can create a scene
without access to a
photo studio - all
you heed is some

space, and a flexible LED light
source with a bundled light cone.
For this project, you need a tripod
to keep the camera steady and
avoid blur, but you won't need a
shutter remote, as the self-timer

FIND THE SCENE

Light sources in the dark, for example,

street lights or coloured fairy lights in your
room, make great subjects, as they're
. naturally colourful with lots of contrast.
| The effect works best when the light
sources aren't overlapping each other

i’

/4

CREATE THE BOKEH

Frame the scene and defocus to the maximum. To
enhance the bokeh, decrease the distance to the light
sources. The further away you are, the more intense the
effect will be. Experiment, and try different compositions
to frame the colourful light orbs.

function will suffice.

Prepare yourself by wearing
black clothes, including black
gloves, to help you to blend
seamlessly with the dark
background. Set your camera to
manual mode (M) and choose a

shutter speed of 3 sec to start.
Bear in mind that
autofocus and

auto-exposure hardware in most
cameras are not designed to
work with monochromatic light.
To ensure sharp images, choose
an aperture of around /8.
Activate the self-timer and
position yourself in front of the
camera. Now, move the light
source around to create different
patterns. Be creative with shapes,
and use coloured light to mix
things up. This technique may
take some time to perfect, as
you'll need to balance the
exposure time and figure out how
y, fast to move the light source to
\, achieve the desired effect.

W\ Coloured LED lights can

A\, be tricky to shoot because
\ colours have different
wavelengths that affect
their visibility. For instance,
blue LEDs have shorter
wavelengths than red ones.
As aresult, you need to
widen the depth of field to
ensure that they appear
sharp and in focus.
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Achieve abstraction by using your camera and lens in a different way

CREATE A ZOOM BURST

DECIDE ON OPTIC

The longer the available focal
length of a zoom lens, the more
intense the effect. Lenses with a
flexible range of 70-300mm are ideal,
but this technique will also work with
slightly shorter focal lengths

PRESS THE SHUTTER

Press the shutter button, and have one
hand ready on the lens to zoom in or out of
the scene - or do both. If longer exposure
times benefit the look of your image, attach
an ND filter to balance the exposure

he joy in creating scenes that
6 don't depict reality is that you

can experiment by playing
around with both the camera and the
subject. Intentional camera movement
(ICM) is one technique that's especially
popular in woodland and nature scenes
to add a dynamic and painterly style.
This approach works by setting a longer
exposure time, and moving the camera
while the shutter is open. These images
often have a captivating abstract blur
that conveys a sense of movement
while blurring colours and shapes.

This technique thrives on vibrant
colours and structures, which the
captured scene should provide.

A beach scene, sunset or flower field
are other great subjects that may also
create an intense effect. When deciding
on a subject to capture, analyse the
scene and the direction of lines, and
work out what type of movement will
enhance the subject. This is often
achieved by adapting the subject'’s
shape in the movement, for example,
imitating the lines of the tree trunks by
moving the camera up and down.

BALANCE EXPOSURE
To avoid overexposing your image,
use a closed aperture of around f/22.
Start with a shutter speed of 1/13 sec,
and experiment with this setting, as it
~ willdepend on how quickly you zoom

As the name of the technique
suggests, there are no rules in terms
of the kind of camera movement you
perform. However, it's useful to know
what type of movement creates each
effect. To achieve a panoramic glide
effect that generates a multitude of
colours, move the camera from side to
side. A drop motion can be created by
mounting the camera on a tripod and
moving the camera downwards using
a fluid ball head or tripod handle. If your
camerais on a tripod, it's also worth
trying a 360-degree rotation effect.
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FAKE AN ICM IMAGE

Use your lens filter to simulate camera
movement

ICM is a great technique for exploring new
visual possibilities in a scene. However, if you
have a specific idea of how you want the final
image to appear, finding the right balance
between movement and shutter speed to
get the desired effect can be tricky, and you
can also apply this effect in a more controlled
manner with simple and inexpensive tools.

To do so, you need a clear filter that does
not affect the overall image. A UV filter, which
is often used to protect the lens against sand
or water, is ideal for this. These filters are
cheap, reusable and can be easily cleaned.

To simulate the effect before shooting, you
will also need a jar of petroleum jelly, such as
Vaseline.

Once you have your tools, mount your
camera on a tripod - it's best to activate live
view mode so that you can preview the results.
Work with an aperture of around /8, and keep
your ISO value low by adjusting the shutter
speed until a balanced exposure is achieved.
Attach the UV filter, and smear the petroleum
jelly on its surface.

Control the effect by smearing the jelly
in a particular pattern - horizontal lines, for
example, will create vertical blurred streaks.
Start with a minimal amount of petroleum jelly,
and add more as needed. If you're not satisfied
with the initial results, wipe the petroleum jelly
off with a damp microfibre cloth, and dry the
surface afterwards with a different cloth before AFTER
trying again.
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SHOOT WITHOUT A LENS

Go back to the early days of photography by creating a pinhole camera to shoot appealing abstracts

The camera obscura, also known as a pinhole camera, was the first
camera created, and has been around since the fifth century BC. As part
of his studies on how we see, the Arab scholar Ibn Al-Haytham is credited
with inventing this camera, showing how light can be used to project an
image onto a flat surface.
The camera obscura works without a lens, and it results in
soft and slightly blurred images. To make one yourself, you'll
need a spare body cap, a drill, some aluminium foil,
a needle and some sticky tape. First, create a card
or paper template of the body cap by drawing
around it and marking the centre point. Place
the template over the body cap, and drill a
hole with a diameter of 2-4mm.
To create the pinhole, cut off a small
piece of aluminium foil and carefully prick
a hole in it - the smaller the hole, the
sharper your image will be. Use a piece
of tape to attach the foil to the cap in the BN TURN BACK TIME
centre. Attach the body cap instead of the

Shot with a pinhole camera, this scene has a
lens, and find a suitable subject for your b

blurred, abstract effect, which is in stark contrast

shoot. In manual mode set ISO to 100 and ;
- tothesth ess of a modern DSLR or mirrorless
try an epxosure of 2 secs on a sunny day. ' - _m »
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ne way of turning reality
upside-down is by blending
together many images of a
commonly photographed subject, such
as birds. This technique of interlacing
frames has lots of potential for creating
abstract images and, by learning how
to use it, you can convey the natural
movement of animals in a unique
manner, as wildlife photographer
Raghuvamsh Chavali explains..

‘Interlacing frames involves
capturing consecutive frames of the
bird's movement (see image above).
The technique can be used to create
and showcase smoother and more fluid
motion when displaying bird flight or
other rapid movements, using a burst
mode or video timelapse footage.

With this technique, the motion
appears more natural and less choppy,
enhancing the experience.

‘I will frequently observe birds
gracefully gliding through the sky,
creating picturesque scenes, like artists
with their brushes. It's captivating to
witness their flight patterns. While it's
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common to spot them in nature, forests,
countryside and lakes, | find it intriguing
to see them in urban environments. |
often liken the journeys of humans to
those of birds, noting how both species
navigate distinct paths to reach various
destinations.

“That's why | began capturing what
| call "Wings Over Concrete’, to create
composite photographs, showcasing
these distinctive flight patterns both in
nature and urban settings. To apply this
technique, | choose higher frame rates,
such as 100fps, for fast actions and
complex manoeuvres of birds in flight.
When capturing regular flight patterns,
| use slower rates, like 50fps, to ensure
smoother playback. It's important to
use the highest resolution supported by
your camera, such as 4K, to capture fine
details of the birds’ movements and
features. Use manual focus to precisely
control focus on the subject, ensuring
clarity in each frame.

“Then, set the frame composition
before initiating recording to capture
the desired scene effectively. I'll also

IN-FLIGHT MOVIE

To achieve this abstract effect,
Raghuvamsh used multiple images of
birds in flight, adding layers of interest
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RAGHU\IAI"ISH CHAVALI

Raghuvamsh Chavali is

a nature and wildlife

photographer. He's

originally from India, and

now lives in Canada. His

photography involves
travelling to remote locations to create
inspiring images that capture the emotional
energy of the place. His work has been
featured in publications such as Canadian
Geographic, Smithsonian Magazine and
Lonely Planet.

Chavali is also a researcher in digital and
biometric data, and has patented a digital
watermarking system that incorporates
human biometrics into imaging systems to
help prevent theft. His academic work has
been published in international journals,
including the JICS and the AJPCR.
raghuvamsh.com
(9) @chavaliraghuvamsh

leverage features such as the Sony
A7Ill's MF Assist, which zooms in when
adjusting the focusing ring, providing a
clearer view for precise focusing on the
birds’ movements.”

2x © Raghuvamsh Chavali
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BLENDING FRAMES create one frame in post-processing

IMPORT VIDEO FRAMES
After capturing your video, carefully align and blend each frame
using specialised image processing software, such as Adobe Photoshop

or any other editing tool. Go to File > Import > Video Frames to Layers to
import the footage.
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SELECTIVE FRAMING
Now go through the process of selecting the best frames and
eliminating any shaky ones. Ensure that the final image is clear and crisp

so that it beautifully showcases the intricate details and grace of the
bird’s flight path.

PRO ADVICE Raghuvamsh's composition

and post-processing tips

EXPERIMENT WITH COMPOSITION

Embrace creativity by creating your own unique
compositions. Try experimenting with different
framing techniques without worrying about the
traditional rules of photography. Your composition
should showcase your personal style, making it
recognisable in the world of photography.

POST-PROCESSING MASTERY

Improve your skills in post-processing by creating
your own presets and editing techniques. Add your
personal touch to every image through careful
editing, making sure your unique style stands out in
the final picture.

import Video To Layers

Range To import
Fram Bagenwnierg To Ena
©Q Saimctid Fange Dy
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SET IMPORT OPTIONS

Now a setting window will open. Here, it is important to leave both
the Selected Range Only and the Make Frame Animation settings ticked.
For the best results, don't forget to enable ‘Limit to Every' and select five
HEIES

CREATE ONE FRAME
Then it's time to flatten the image to create one final photograph.
For my work, | convert the image tones to monochrome. Instead of

changing the Mode, go to Adjustments > Black & White to gain more
control of the tones.
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© Raghuvamsh Chavali
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How refracting daily scenes through frosted glass can enhance your images

MYSTICAL ENVELOPING

The structure of the glass
highlights a range of colours, and
also adds extra layers of interest

© Ladoza

s a conceptual artist with
a passion for abstract art,
Ladoza loves exploring different
mediums and techniques to create new
concepts. Photography remains key to
this process. "As with music, abstract
art can reflect our moods or embrace
our feelings. It shifts the importance of
knowing what you are looking at to how
it makes you feel,” he says.

“The Viewing Glass project (the
working title) is still in its early days,
and with every shoot | continue to learn

what it is and see how my objectives
are evolving. My focus isn't on the final
piece, but rather on the process and
exploration of an idea.

“The concept came to me while |
was looking through a textured glass
window. Instead of seeing the window,
| saw bold, distorted shapes and
colours, similar to an impressionist
painting. | was inspired to create
something that | could use to capture
the landscape in a way that looked like
a real-life oil or pastel painting.”

Ladoza is a multi-media

abstract and conceptual
. artist, based in Sheffield,

UK. With a passion for

nature and the outdoors,

Ladoza takes inspiration
from the surrounding landscape to explore
and develop new artistic ideas through
painting, photography and other media.
ladoza.co.uk (€] @ladoza.uk


http://ladoza.co.uk
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PRO ADVICE Ladoza explains how to

create abstract art through frosted glass

TRY, ANALYSE, REFLECT

Don't ask yourself why you want to create an image.
This can get in the way of producing it in the first
place. If you get an idea, try it out, then ask yourself,
how do you feel about it? What have you learnt? How
could you improve? That way, you can reflect and
learn from what you've created and evolve from there.

CREATE A CONCEPT

Abstract art and photography is about exploring your
own concepts, not necessarily complying with what
others want you to do. Knowing this can be liberating
and free you up creatively.

GET INPUT

There is a lot of value in being self-critical, especially
if you learn how to do it constructively. Visiting
galleries and thinking about why you like - or

more importantly, dislike — a piece, can help in the
development of your own creations.

SHOOT REGULARLY

People often say ‘Get out and shoot more’ when
talking about photography, but what they don't say
is why this is important. We only learn more by doing
and reflecting. The more we do something, the more
we learn from our mistakes and become better at
what we do.

© Ladoza
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-

GLASS FRAME

The glass effect is in direct
contrast to the background. It
becomes clear how the structure
of the glass changes the scene
into a painterly frame, setting the
focus clearly on structure and

LONG EXPOSURE i colour of the subject
Ladoza captured the scene using
an extended shutter speed. As a
result, the movement of the water
is softened, giving it a dreamy effect.
This is a common technique that's
used in landscape photography to
P, transform scenes

Ladoza

©
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INCORPORATE FILTERS

Whatever abstract effect you want to create,
there's probably a filter that can help

TRANSFORM COLOURS
Infrared filters are a great tool
for creating abstract-looking

landi%'images

© Ben Brain

V filters, polarisers, and other However, whenever you decide to use. Initially, you may wish to purchase
similar filters are commonly used  purchase afilter, it's important to consider — a budget-friendly filter to determine
to protect the lens or to enhance its material. Filters made from plasticare  whether it's worth investing in high-

the overall look of your image. However, often cheaper, but they can negatively quality filters later on. To give you an idea,
there are some specialised hardware affect image sharpness. On the other here are two unusual filters that can add
filters you may not have heard about. hand, more expensive high-quality filters  an abstract touch to your photography.
That's probably because they're not are made of optical resin or glass, which Both effects are also achievable in post-
suitable for every photo project, as they are less prone to scratching, which helps  processing, but attaching a filter will save
add distinctive visual effects to the frame.  to maintain their quality during regular you hours in editing.

INFRARED FILTER

IR filters don't affect the subject’s form but its colours. The tool cuts
wavelengths and permits transmission of the red region of the light
spectrum, resulting in frames that look surreal in their colours. When
using filters such as the Hoya R72, bear in mind that setting the focus
accurately before attaching the IR filter is a must. These filters cut
down the overall exposure, so working with a tripod to slow down
the shutter speed is advisable.

I ——
KALEIDOSCOPE FILTER

Many of us may recall playing with a kaleidoscope toy in our childhood,
and kaleidoscope filters work like those, creating a unique visual
experience that’s akin to looking through one by splitting images into
fractions, mirroring them and rotating some elements. To create this effect,
the Subtle Kaleidoscope filter

from Freewell is an excellent
choice, transforming
ordinary subjects into
mesmerising and
enchanting artworks.
To maximise the effect,
shoot colourful scenes
with small subjects and
details, such as stained
glass windows or fields
of flowers.

= SUBTLE KaLEIDOSCOPE
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ONE TOO MANY
RUBEN ALEXANDER

“Glassware photography is challenging, and here I attempted
to challenge myself even more by introducing some drama.”

https://bit.ly/4a0dgn
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https://bit.ly/4a0dqnC

THE WEEK'S MOST INSPIRING READER PHOTOS

SNAKESHEAD FRITILLARY
JUSTINE GORDON
“I was so excited to find this snakehead fritillary in the park one
morning recently - I took it as a sign of spring finally arriving.”

https://bit.ly/4alMQOK


https://bit.ly/4a1MQKO

THE WEEK'S MOST INSPIRING READER PHOTOS

SETAS DE SEVILLA
RODRIGO GODINEZ
“The Setas de Sevilla (‘Mushrooms of Seville’) is a wooden structure incorporating
a market, museum and restaurants in the old quarter of Seville in Spain.”

https://bit.ly/3CziEHM


https://bit.ly/3CziEHM

FACEBOOK

http://bit.ly/39py9lg

THE WEEK'S MOST INSPIRING READER PHOTOS
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RED-HEADED WOODPECKER
TOM MORTENSON
“A colourful red-headed woodpecker with its future dinner,
a prized acorn. Taken in Portage County, Wisconsin, USA."

https://bit.ly/3EvkdWb

PHOTOGRAPHY WEEK WANTS YOUR PHOTOS!

Taken a portrait you're particularly proud of? Shot a sensational sunset you'd like to
show off? Then join the Photography Week Facebook community and share your best
photos today! You'll get feedback from fellow readers and the Photography Week
team, plus the chance to appear in Xposure, or even on our cover!


https://bit.ly/3EykdWb
http://bit.ly/39py9lg
http://bit.ly/2VIgsJO

Visit our website - updated daily
www.parkcameras.com

or call us 7 days a week on

01444 23 70 59

PARKCameras

The Latest New Products & Special Offers

available from Park Cameras!

OM System OM-1 I

Revealing Wonder

+ 12-60mm PRO I

£2,699%

OM-1 Mark Il Body

£2,199%°

For money saving options with popular OM System lenses,
see our website or call 01444 23 70 59.

OM System OM System
9-18mm 90Mmm
f/4.0-5.6 || f/3.5 Macro IS PRO

Our price
£599%°

NOW IN STOCK!
See website to learn more

Qur price
£1,299%

Spread the cast with our
finance options. See web.

Sony a7 IV Sony
Body Only FE 16-35mm
f/2.8 GM Il

In stock at only
£2,179%°
12 months 0% finance
available. See website

In stock at only
£2,299%
Add a Hoya 82mm HD |l
UV filter for £98

Calibrite
Display 123

Monitor Calibrator

Vanguard

VEO City B42
16 Litre Backpack

Our Price
£109

NOW IN STOCK!
See website for details

Our Price

Expected March 2024
See website for details

Fujifilm X100V

The One and Only
40

MEGA
PIXELS

Scan here
to watch our
hands-on review!

S e T W =

X100VI

£1,599%°

our finance options.
See website.

£1,648°°

OM System Fujifilm X-T5 Fujifilm X-H2S
150-600mm Body Only Body Only
f/5.0-63 IS

FlsFmm

P o

In stock at only

£1,999%

Add the VG-XH battery
grip for only £399

Our price
£2,499"

NOW IN STOCK!
See website to learn more

In stock at only

£1,649°°

12 months 09 finance
available. See website

Sony Sigma 85mm Sigma 105mm
FE 24-50mm f/1.4 DG DN | Art f/2.8 DG DN | Art
f/2.8C

Sony E / L-Mount
£879°

*Mormally £979.00.
Offer ends 30.04.24

Sony E / L-Mount
£629

Our price
£1,149°°

Expected May 2024
See website for details

*Normally £729.00.
Offer ends 30.04.24

LEICA SL3
Body Only

Our Price
£5,920

Expected Spring 2024
See website for details

+ Weather Resistant Kit

to watch our
hands-on review!

Available in Black
or Silver Designs

Due to unprecedented global demand, manufacturing capacity is being
increased but dates for supply are unknown. See website for latest details.

Fujifilm
XF 100-400mm
f/4.5-5.6 R LM QIS

In stock at only
£1,399%

12 months 0% finance
available. See website

SAVE
£100

on selected
SIGMA miirrorless
ART lenses.

Visit us in store
or online to see
the full range.

B Offer ends 30.04.2024. |
] - ¥

TRADE-IN OR SELL YOUR KIT

AR lel ISy Mo Vel = values received INSTANTLY
3= 3 el A Jaa (e /B =V/[e38 See website to learn more
LRVl =E R le VIS8 available on a wide range of products

FREE HOME COLLECTION AVAILABLE®

*For equipment valued over £300

WWW.PARKCAMERAS.COM/TRADE-IN

All prices Include VAT. All products are UK stock. ES&OE. Please mention “Digital Camera Magazine™ when purchasing from this advert
Prices correct at time of going to press; Prices subject to change; check website for latest prices.
Please check website for special offer end dates.

Trustpilot 3 5 5 % %




TS COOL, THAT

THE BEST THING WE'VE SEEN THIS WEEK

Saeed Rezvanian, Overall Winner

Images © The photographer and courtesy Concrete in Life 2023

Andre Hidayat Arrasuli, Winner, Concrete Infrastructure

CONCRETE PROOF THAT GREY
DOESN'T HAVE TO BE BORING

Photo contest celebrates the enduring power of the world's construction material

oncrete might not be the first thing
e that springs to mind when you think
about photogenic subjects, but the
Global Cement and Concrete Association
(GCCA) wants to persuade you otherwise
- and looking at the winning images from
its 2023 Concrete in Life photo competition
we'd say they're onto something.
Entrants were invited to submit images
capturing the importance of the ubiquitous
and sometimes beautiful building material

across four categories: Urban Concrete,
Concrete Infrastructure, Concrete in Daily
Life, and Beauty and Design. Saeed
Rezvanian was named overall winner for
his captivating image of a child playing
with a kite in Mexico's Teopanzolco Cultural
Center, a concrete building which adjoins
an archaeological site with Aztec ruins.

The contest attracted more than 21,000
entries - click the link to see all the winning

and shortlisted images at the GCCA website.

SEE MORE TMAGES
https://bit.ly/kaTIAt6



https://bit.ly/4a7IAt6
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CRASH COURSE

ESSENTIAL PHOTO SKILLS MADE EASY

LET THERE BE LIGHT LEAK!

Jason Parnell-Brookes shows you how to add a light
leak effect to a digital image using a match

ack in the days of film, if you creative technique that enhances images By striking a match or igniting a

had a gap in your camera beyond their standard exposure. lighter, we can create a warm orange

body, light would leak in Light leaks have become a popular flicker of fire, and if we place this

through the cracks and tinge ‘retro’ effect to add to digitalimages - it's | close in front of our lens and focus on
the film with colour casts across the usually done in post-production using something in the distance we can blur
frame. This exposure to light, or ‘light various techniques, but there are also the flame to imitate a light leak. Here's
leaking’, was originally seen as a problem | ways that you can simulate a light leak how it's done - just be careful not to get
to be avoided, but it's caught on as a in-camera, even in the digital era. the flame too close to your camera!

bib




STEP BY STEP CREATE A LIGHT LEAK EFFECT

1

SAFETY FIRST

At the risk of sounding like a health and safety
inspector, you need to take safety precautions
where fire is involved. We brought a bucket of
water to extinguish our matches (and to use
in case we dropped them on the floor). We
also prepared a damp towel to deal with any
accidental burns.

FOCAL LENGTH

We found that a s0mm f/1.4 lens was perfect
to frame a portrait nicely while simultaneously
compressing the perspective enough to blur
close-up foreground elements sufficiently.
The wider the lens, the less perspective
compression you'll get.

WINDOW LIGHT

We shot our light leak portrait indoors so that
the ambient light was lower than if we were
outside, which ensures our blurred flame
stands out. Window light also has a lovely
quality, creating soft shadows and smooth
highlights that wrap around your subject.

DON'T GET BURNED

It's easy to get wrapped this project with regular- to your finger. Regular

up in shooting and forget sized matches, get a friend  pocket lighters also get
about how quickly a match  or your model to warn you hot quickly, and so are
is burning down. If you try when the flame gets close  best avoided.




STEP BY STEP CREATE A LIGHT LEAK EFFECT

O

CAMERA SETTINGS

In Manual mode we set our ISO to 400 to

V.

OF2

Sl s g e wiakes vt compensate for the lower light levels indoors.

' B
1SO We set our aperture to f/2 to blur the flame
4 0 sufficiently, and our shutter speed to 1/500

sec, which was fast enough to keep the image

D__||65 EﬁﬂFF @NL EAUT[h mm sharp as we were shooting handheld.

151 (7] RAW <
AF-C (366]

B = AELIAF-ON @ OFF

5

MATCHES/LIGHTER

We recommend using long cook’s matches, a
taper or a long-necked lighter. These will give
you a longer burn time before either the match
burns down or the lighter gets so hot that it
burns your fingers or thumb.

GETTING THE SHOT

We were careful not to melt the edge of our
lens, but we had to hold the match close
enough to the front element in order for the
flame to blur. If you're not confident about
doing this, use a lens hood to keep the fire
away from the glass.




HOW TO...

CAMERA RAW & LIGHTROOM
LEARN ESSENTIAL EDITING SKILLS FAST!

[>]

WATCH THE VIDEO
https://bit.lv/3wYLH6A

WHY PHOTOSHOP ISN'T
THE ONLY GAME IN TOWN

Tidy up messy areas of your images in Camera
Raw and Lightroom with James Paterson

any of us who've been using
Adobe editing tools for years

find that there's less and less

reason to open our images in Photoshop.

Instead, Camera Raw and Lightroom
offer almost everything we need to edit
our images. But for precise retouching
work, Photoshop has always been better
— that's until now.

The latest updates to Camera Raw
and Lightroom include a Content-Aware
healing feature that could be a game
changer for your raw editing workflow.
Content-Aware Fill lets you target an

object, then watch as Photoshop
removes it. Now we can use the
Content-Aware Remove tool in Camera
Raw and Lightroom's Develop Module
to reach similarly impressive results,

by simply painting over a distracting
object or detail.

Of course, the results won't be
perfect every time. But, as you'll discover
in this issue's video tutorial, by using the
Content-Aware Remove tool with the
other tools in the Healing panel, you can
usually tidy up images without having
to import them into Photoshop.

DOWNLOAD THE
PROJECT FILES
https://bit.lv/3vpwegFx

ON A PCOR MAC

EXPERT TIP

We've supplied 10 profiles with your

video. Import them into Camera Raw or
Lightroom. In Camera Raw, go to the Basic
panel, click the Profile Browser grid, click
the three-dot icon and choose Import
Profiles and Presets. The profiles will sync
to Lightroom. Check the box and you'll see
a black-and-white overlay. This seeks out
edge details by dividing the image into
high-frequency (white) and low-frequency
(black) areas. The slider lets you fine-tune
the divide. The overlay makes it easier to
detect sensor spots; paint with the Healing
Brush to remove them.


https://bit.ly/3vpwgFx
https://bit.ly/3wY4H6A

COMPACT CAMERA TEST
EXPERT OPINION ON THE LATEST KIT

FUJIFILM X100VI

It looks like its predecessor, but it packs in some stealth upgrades

he overnight success of the
o Fujifilm X100V took everyone

by surprise - and no one was
more surprised than Fujifilm. The
X100V was launched in 2020 as the
fifth iteration of the brand’'s premium
compact, and its sudden popularity
among TikTok influencers led to a
six-month waiting list to buy one.

Now Fujifilm is back with the

X100VI. As with its predecessor, the
premium vintage aesthetic is made
for street and travel photographers
who want a pocket-friendly camera.
The X100 range is also one of the few

lwww.fujifilm.coml £1,599/51,599

true rangefinder designs still being
made, with the pricier manual-focus
only Leica M11 the only other option
with an optical viewfinder.

Key features

Externally, little has changed from the
previous model, but when you have a
viral success on your hands you don't
want to rock the boat. The body and
fixed 23mm lens are identical to the
X100V's, with the major improvements
hidden inside the camera. The X100VI
sees a bump in resolution from the
X-Trans 5 sensor from 24MP to 40MP,

with video now topping out at 6K. The
new X-Processor 5 also powers better
autofocus, with subject recognition
and tracking for faces, eyes, animals,
birds and vehicles. For those who own
the Fujifilm X100V, the question is
whether the Fujifilm X100VI is worth
the upgrade.

Build and handling

The design is near-identical to the
X100V, but that repetition is no bad
thing. The X100 series harks back to
rangefinder film cameras from the
film era, and the X100Vl is built to a


http://www.fujifilm.com

COMPACT CAMERA TEST FUJIFILM X100V

1 The body (in a silver or black finish) and
the 23mm lens are identical to the X100V.

2 The lens has a control ring, which by
default controls the camera’s digital zoom.

3 One minor quibble is with the grip, as there
isn't really a huge amount to cling onto.

&4 One of the X100VI's highlights is the
hybrid optical viewfinder: in use, it's a
great experience.

5 If you prefer an electronic viewfinder,
a flick of a switch swaps the screen for
a 3.69m-dot OLED EVF.

6 The screen only has a 902 horizontal tilt,
limiting its usefulness for filming as you
can't flip the screen.

1 There are two dials on the top - one
handles exposure compensation, and the
other shutter speed.

8 The shutter speed dial has a clever trick
whereby you just lift and twist to set the
ISO value.

9 Aperture is changed via a ring with two
raised handles, which is easy to turn with
one finger.

premium standard that feels fantastic
in the hand.

Fujifilm remains committed to
dials on its cameras, and there are
two on top, one handling exposure
compensation and the other shutter
speed. This shutter speed dial also
has a clever trick whereby you can
lift and twist it to change the ISO. The
aperture is handled by the ring on the
lens, which has two raised textured
handles and is easy enough to turn
with one finger, and the clicks at
each aperture stop are audible if you
don't want to take your eye off the
viewfinder. But if you just want to point
and shoot, you don't have to worry
about these - all the dials have an auto
setting, or you can mix manual with
auto to shoot in aperture priority or
shutter priority modes. And like other
Fujifilm cameras, if you'd prefer some
manual control, you can delve into the

FUJIFILM  comoi
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menu and set the camera up to cycle
through aperture and shutter speed
using the thumb and finger wheels.
As noted, the lens is unchanged
from the X100V - although that
was an outstanding revision, and
offers incredible sharpness. The
23mm focal length is spot on for

a compact camera, as it works for
travel, street and environmental
portraiture, although | would have
liked a wider aperture to expand low-
light performance and creativity with
shallow focus. There's also a control
ring on the lens - while you can set
this to several different functions in



COMPACT CAMERA TEST FUJIFILM X100V

the settings, by default it controls the
camera’s digital zoom - that's digital
zoom, not optical, so the camera will
crop the image for a smaller pixel
count. Where the X100V's 24.1MP
sensor limited the digital cropping'’s
effectiveness, the 40MP sensor in the
X100VI seems made for this feature,
with 50mm (20MP) and 70mm (10MP)
crops still holding a lot of resolution.

The lens is compatible with the
existing wide and tele lens converters
released alongside the X100V. One
frustration for anyone who wants to
put a filter on the front of their lens,
though, is the required additional
purchase of a filter adapter ring (AR-
X100) - it's also the only way to make
the lens water-resistant.

One of the highlights of the X100
series is the hybrid optical viewfinder
- one of the last remaining optical
viewfinders in a world full of EVFs.
Due to the rangefinder design, the
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Although our lab tests showed increased noise from the X100VI compared to the X100V, many of our
test shots were taken at night, and even at IS0 6400 or 12,800 images were usable

viewfinder doesn't perfectly line up
with the sensor, but there is a digital
box projected in the optical viewfinder
that shifts depending on shooting
distance so that you know what's in
your shot. It takes some getting used
to initially, but after a while it becomes
second nature. If you prefer to use an
electronic viewfinder, a flick of the
front switch activates the 3.69 million-
dot OLED EVF.

The screen is a 1.62 million-dot
LCD panel, and while vloggers might
be disappointed to hear that the
screen still doesn't flip around so that
you can see yourself while you're
recording, it does tilt by 90 degrees,
and still sits beautifully flush with the
camera body.

One minor quibble with the build is
the grip. Though it's more substantial
than the X-E4's, there isn't a huge

3% © Gareth Bevan



COMPACT CAMERA TEST FUJIFILM X100V
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Video quality is good, and at 6K there’s a sharpness to the
footage. The IBIS held shots steady, but some jerky movements
managed to slip in, so you may want to invest in a gimbal

"EXTERNALLY, LITTLE HAS CHANGED
FROM THE PREVIOUS MODEL, BUT
WHEN YOU HAVE A VIRAL SUCCESS,

e

: (_.

The lens is compatible with wide and tele lens
converters released with the X100V - however,
if you want to use filters, you'll need to
purchase a filter adapter ring

YOU DON'T ROCK THE BOAT"

| amount to cling onto, and your little

finger will be lost as to what to do
with itself.

Performance
The X100V set some lofty expectations
with its outstanding image quality, but
the X100VI exceeds them. Edge to
edge, images are sharp and detailed,
with excellent contrast. Fujifilm's colour
science is among my favourites, and in
the standard Provia simulation colours
are pleasing, with a good balance of
natural colour and saturation. If you
don't like that, there are always another
20 simulations to try.

In our lab tests, noise at higher
ISOs takes a hit over the X100V due

to smaller photosites on this higher-
megapixel sensor, but in real-world
use this is far less noticeable. | shot
the neon lights of Tokyo at night with
this camera and, even at ISO 6400
or 12,800, images were usable, and
didn't look any noisier to the naked
eye than images from the X100V.
Peeping in the corners, there doesn't
seem to be any obvious softhess

or vignetting in JPEGs, even when
stopped down to f/2.

Autofocus is improved, and makes
the older model feel significantly
slower. On the X100VI, AF is quick and
silent, and in continuous focus the
camera had no problem holding focus
on my subject as they wandered
about the frame.

As well as human faces and eyes,
the X100VI's autofocus also now
recognises subjects including animals,
birds, cars and other vehicles. Some
of these options feel less essential on
a 23mm fixed-lens camera, but they're
good to have, and vehicle tracking
worked well in my testing.

© Gareth Bevan
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COMPACT CAMERA TEST FUJIFILM X100V

“THE X100V SET SOME LOFTY EXPECTATIONS FOR
ITS IMAGE QUALITY; THE X100VI EXCEEDS THEM”

Images from the X100VI are sharp and detailed,
with excellent contrast. Fujifilm’s colour science
is renowned, and the standard Provia simulation
colours are pleasing, with a good balance of
natural colour and saturation - and there are

a further 20 simulations to choose from

Battery life is still a weak point for
the X100 series. It was my main gripe
about the X100V, and although the
new processor is meant to improve
efficiency it hasn't moved the needle
that much. During a few intensive
days of shooting | was easily burning
through a battery or two a day, so it's
advisable to invest in a few spares.

Film simulations are one of the
top selling points for Fuji cameras,
and Fujifilm has taken the number
of film simulations up to 20 - adding
the Reala Ace simulation to an
X-Series camera for the first time.

SENSOR: 40.2MP X-TRANS CMOS 5 HR
SENSOR PROCESSOR: X-PROCESSOR 5
LENS: FIXED FUJINON 23MM F/2.0 II (35MM
EQUIVALENT) VIEWFINDER: 3.69M-DOT
OLED EVF / OVF HYBRID SCREEN: 3.0-

IN 1.62M-DOT 2-WAY TILT TOUCH LCD

MAX BURST: 11FPS (MANUAL SHUTTER),
20FPS (ELECTRONIC SHUTTER) IMAGE
STABILISATION: IN-BODY ONLY, 6.0 STOPS
VIDEO: 6.2K 30P, 4K 60P, HD240P, 4:2:2
10-BIT, F-LOG, F-LOG2 MEMORY: 1 X SD/
SDHC/SDXC, UHS-I SIZE (L X H X D): 128

X 75 X 55MM WEIGHT: 521G (INCLUDING
BATTERY AND MEMORY CARD)

Film simulations are lots of fun on
their own, but also a quick and easy
way to stylise a photo right out of the
camera. For the more creative, they're
also a great building block for recipes
to produce even more complex and
accurate film looks.

Video performance gets a boost
from the new sensor and processor.
The X100VI tops out at 6K 30p

footage, although this has a 1.23x crop,

which makes the 23mm lens a 28mm

lens (or a 42mm full frame equivalent).

The X100VI is also capable of 4K 60p
footage without a crop, or 1080p
footage up to 240p. Video recording
is good - filming at 6K, there's a real
sharpness to the footage. The IBIS
also managed to hold my static shots
steady, and panning was definitely
improved, but if video is your priority
there are more suitable cameras.
Overall, the X100VI is a great stills
camera that also shoots good video
when needed.

Gareth Bevan

VERDICT

Fujifilm’'s uber-popular compact
returns, and while not much has
changed externally, inside it's a
different story. The new sensor
takes the renowned quality of
the previous model and pushes it
further. Image quality is excellent,
autofocus is faster, and video has
been greatly improved. One sore
point is the battery life, which
hasn't really improved from the
previous model. The X100Vl is also
more expensive than the X100V,
and it might be more than some
are willing to pay for a fixed-lens
compact - you'd have to value this
design over cheaper but similarly
specced cameras.

1 8. 8.8 & ¢

LAB TESTS

RESOLUTION (LINE WIDTHS/PICTURE HEIGHT)
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We tested the X100VI against the Fujifilm X100V,

the Nikon Z fc and the Ricoh GR III. Fujifilm's switch
from a 26.1MP to 40.2MP sensor pays dividends when
it comes to resolving fine detail, with the X100VI
leading the pack at all sensitivities, and capturing
noticeably more detail than the X100V.

SIGNAL-TO-NOISE RATIO (oecseLs)
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The X100VI can’t match the X100V for image noise
levels. Cramming extra pixels onto the same-sized
APS-C sensor means each photosite (pixel) is smaller,
making it more likely to generate noise.
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At higher sensitivities the X100VI falls short of the
X100V, capturing around 1EV less dynamic range
between IS0 3200 and 12,800. Pixel-packed sensors
benefit resolution, but impact the dynamic range.
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